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Introduction 
Set up and run a full pari-mutuel betting pool for your Derby Day party! This includes taking Win/Place/Show/ 
Exacta/Trifecta/Superfecta bets, showing real-time odds to your party guests, printing bet slips, and computing all 
payouts… all for free!! *   

Usage Instructions 

Pre-race Preparations 

1. Clear sample data 
In its default state, this spreadsheet contains sample bets and data so you can see how it works on a sample Derby 
Day party.  Since Derby Day does not contain any macros, you will have to manually clear the data for your own 
party. Here’s how to clear all the data: 

a) In the Entries tab, clear all Yellow cells, including the Race Name 

b) In the Bettors tab, clear all Yellow cells  

c) In the Bets tab, clear all Yellow cells, including any Gray cells in Columns F & G 

d) In the Exotics tab, clear all Yellow cells (if highlighted).  

e) In the Results/Payouts tab, clear all Yellow cells.  

2. Enter Horses (Entries Tab) 
Begin by entering the Race Name (i.e., “Dave’s Kentucky Derby Party”) and the Type of event (Horse, Car, Golf, or 
other).  

Also enter the level of Betting Options for your event. If you are running a simple event with a few non-bet-savvy 
people, then perhaps just stick with “Win Only” bets. If you are having more people (and more money) then 
consider “Win Place Show” bets, and for very large events with savvy handicappers then give “Exotic bets” a try! 

This is also where you can enter the “Track Takeout” – a percentage amount that you remove from the pool to 
cover your own personal expenses that you spent throwing the party.  

You can also specify the Breakage and Rounding of this event – this is the minimum unit of payout for the winners.  
It can range from pennies to dollars, which may help you dealing with loose change when paying out from the 
house. 

Name, Jockey, Trainer, etc. for each horse (Entry) in the race. Many of the columns are optional, but Name and Post 
Position are required.  

 
* Yes it’s free, but donations are gladly accepted. See the “Credits” section at the end of this document.  J 



On Derby Day 

3. Register Bettors (Bettors tab) (optional) 
If you like, bettors can be registered to make individual bets easier to record and/or pay out. They can be typed in 
manually, or just copied from your email guest list or another spreadsheet. This step is optional – if you don’t want 
to register bettors then you can just enter their names individually on the Bets tab. 

4. Take Bets (Bets tab) 
During your party, people can place bets (Win or Win/Place/Show) on any of the entries in the race. As bets are 
made, the real-time odds are re-calculated and (optionally) shown to the party guests for future bets. See the 
“Configurations” section below for possible bet-taking scenarios. 

a. Exotic Bets (Exotics tab (optional)) 
If you have the Exotics betting option selected, then use the Exotics tab to take your bets. Exotic bets can 
include Exacta, Trifecta, and Superfecta, and boxing those bets for up to seven entries. Enter the per-bet 
wager, and the total amount of the bet will automatically be computed. (please note that Exotic odds are 
not displayed on the Odds sheet in this version) 

b. Show Live Odds (TV View tab) (optional) 
If you have dual monitors or another computer, consider displaying the Live Odds on a separate screen for 
your party guests!  You can switch between Odds-only, Results-only, or a full view of both by clicking the 
blue arrows. Please note the TV View sheet may require adjusting the Zoom and/or scroll so it will fit nicely 
on your particular screen. 

c. Print Bet Slips (Bets and Exotics tabs) (optional) 
If you have a printer set up then consider printing Bet Slips for your party guests, just like at the track!  Just 
enter the Bet ID and then press CTRL-P to print. (please note the Bet Slips are pre-formatted for a portable 
label printer but should work with any paper size. 

 

 
 

6. Show the results, and compute payouts (Results & Payouts tab) 
Once the race has concluded, enter the final results (by their post positions) into the Results tab to compute the 
final payouts. Winning bets will be color-coded on the Bet and Exotic sheet for easy reference, and a summary of all 
winners and payouts will also be shown on the Winnings tab. 

  It’s that easy! J   
 

 



Possible (and Recommended) Configurations 

Single bet-taker 
In its simplest form, one person controls the entire pool, taking bets, entering them into the sheet, informing 
bettors of the current odds, and computing (and distributing) payouts. This could be accomplished on a single 
laptop, or (better) on a desktop computer with a large monitor. No internet connection is needed, and 
everything is self-contained. 

Multiple bet-takers 
For larger and more elaborate parties, multiple people could be stationed throughout the premises taking bets, 
live odds could be displayed on an external monitor (see below) and payouts would be computed (and 
distributed) by a central administrator. This is best accomplished by uploading and co-authoring the sheet with 
trusted colleagues via OneDrive*. Bets are entered by each (trusted) bet-taker/user on the shared sheet, while 
live odds are displayed to the bettors in real-time. In this scenario, an internet or LAN connection would be 
required. Be careful not to let unauthorized users have access to the spreadsheet, otherwise some unscrupulous 
persons could create fraudulent bet entries and affect odds/payouts. 

External Monitor for Odds 
To give your Derby Day party a fun racetrack feel and atmosphere, dedicate an external monitor and/or 
computer to display Live Odds via the TV View tab! This can be done in both scenarios above, either via the 
Window -> New Window menu item on dual monitors, or by co-authoring the sheet via OneDrive on a different 
device*. 

 
  

 
* May require an Office 365 subscription. See https://bit.ly/2E4EPEQ for detailed info on co-authoring Excel worksheets. 



Tabs 

Entries Tab 

This is where you enter the Race Setup parameters, and data for each entry in the race.  

Set up the race by entering its name, the type of event, betting options, track takeout (i.e., how much you take 
off the top for expenses), as well as rounding options. 

Space is provided for each entry’s Name, Jockey, Trainer, and Owner, but feel free to add extra data if you like—
only the Name is required. 

Bettors Tab 

This is where you register official Bettors for the race. This sheet is completely optional, but it helps when 
placing bets because the bettor names will be auto-filled in the Bets sheet. 

Bets Tab 

This is where all the bets are entered. They can be entered by a single bet-taker at a central location, or by 
multiple bet-takers sharing/co-authoring the spreadsheet on multiple devices via OneDrive.*  

Enter the Bettor and Entry data (you can either use the drop-down menu or type them in directly) as well as the 
amounts for the Win/Place/Show bets (Place and Show bets are optional, based on your Betting Options from 
the Setup tab).  

Since Derby Day does not contain any macros, you will have to enter the (optional) timestamp manually. To do 
so, press the Ctrl-Shift-semicolon keys. 

If you have an attached printer and would like to print a receipt of any particular wager, enter the Bet ID in the 
Bet Slip section and press CTRL-P to print the bet slip.  

After the race has concluded, all winning bets will be color-coded (Green for Win, Yellow for Place, Blue for 
Show) for easy reference.  

Exotics Tab 

If you have the Exotics betting option enabled, then this is where all the Exotic bets (Exacta, Trifecta, Superfecta) 
are entered. They can be entered by a single bet-taker at a central location, or by multiple bet-takers sharing/co-
authoring the spreadsheet on multiple devices via OneDrive.*  

Enter the Bettor and Entry data (you can either use the drop-down menu or type them in directly) as well as the 
Bet type (Exacta/Trifecta/Superfecta or boxed bet) and the specific entries for that bet (use the entry’s post 
position, not their name). Finally, enter the amount wagered per bet – the number of bets (for boxed bets) and 
total amount with be automatically computed. Be sure to collect the amount displayed in the “Total Cost” 
column from the bettor! 

Since Derby Day does not contain any macros, you will have to enter the (optional) timestamp manually. To do 
so, press the Ctrl-Shift-semicolon keys. 



If you have an attached printer and would like to print a receipt of any particular wager, enter the Bet ID in the 
Bet Slip section and press CTRL-P to print the bet slip.  

After the race has concluded, all winning bets will be color-coded (Green for Win, Yellow for Place, Blue for 
Show) for easy reference.  

Odds Tab 

This sheet displays the real-time odds computed from all Bets placed (via the Bets sheet), as well as a live 
toteboard of all bets collected in all Win/Place/Show pools. This is a fully protected sheet because you don’t 
have to enter any data here (it’s all computed from data in the Bets sheet). 

This tab may be sufficient for most users, but if you are using a dedicated second monitor to display odds then 
consider switching to the “TV View” tab for a cleaner interface to be seen from a distance. 

Results/Payouts Tab 

Once the race has concluded, enter the final results (post positions only) in the designated Yellow cells to 
compute the final payouts.  Winning bets will also be color-coded (Green for Win, Yellow for Place, Blue for 
Show) in the Bets and Exotics tabs.  

This tab may be sufficient for most users, but if you are using a dedicated second monitor to display odds then 
consider switching to the “TV View” tab for a cleaner interface to be seen from a distance. 

Winnings Tab 

This tab displays all Bettors in the race, while highlighting any Bettor who won money via Win, Place, Show, or 
Exotic bets. This is similar functionality to the color-coded rows in the Bets and Exotics tabs, but it just looks 
nicer.  J 

Since Derby Day does not contain any macros, you will have to manually refresh both tables once the race has 
concluded. To do so, just right-click anywhere on the tables and select “Refresh”. 

TV View Tab 

This sheet displays the real-time odds from your bets, as well as the final payouts from Win/Place/Show and 
Exotic pools once the race has concluded. It is presented in a nicely formatted “dark mode” view suitable for 
displaying to your party guests on a separate external monitor.  

You can switch between Odds-only, Results-only, or a full view of both by clicking the blue arrows. 

• If you are displaying this tab on an external monitor, be sure to press CTRL-SHIFT-F1 to enter Full Screen 
mode.   

• Also, this sheet may require Zoom and scroll adjustments so it will fit nicely on your particular monitor.  
• Finally, if you are using the Window->New Window method to display the TV View on an external 

monitor, you may have to manually remove the Gridlines via the View menu (sorry that’s a Microsoft 
thing, not me) 

• This is a fully protected sheet because you don’t have to enter any data here (it’s all computed from 
data in the Bets and Results/Payout sheets). 



Developer Notes 
Here are a few notes that might help with people who are Excel nerds: 

• Many of the tabs are protected to prevent accidental deletion of data. Some of the tabs are fully-protected (TV 
View, Odds, Welcome) while others are just partially protected (a few columns in the Bets tab, and all but a few 
cells in the Result tab).  If you really want to change anything then feel free to unprotect the tabs – there is no 
password. 

• Similarly, if you are a wiz with Excel then feel free to tweak with and improve upon the code as you wish!  Just 
be sure to email me the changes so we can keep up with version control… J  

o Thanks Ron Neubauer for your Excel help!! 

• Derby Day is distributed without any macros enabled, but there is a Hidden tab called “Macros” which contains 
the text of some helpful macros that I have been using. To install the macros, press ALT-F11 to enter VBA and 
copy/paste the code in the Macros tab into VBA. (this step is only for VBA experts—the sheet will work just fine 
without the macros…) 

• Here are some features that I would like to include in future versions. If you have any ideas, send me a message 
(noted below) and I’ll see what I can do 

o Mobile bets (via Google Forms or AWS or MS or some other technology) 
o Bettor online accounts 
o SQL and/or Google Visualization API Query Language 

 

DISCLAIMER AND WARNING and Legal Stuff 
This spreadsheet is intended only for creating a friendly betting pool between friends. It has NO security features and 
does not support any payment schemes besides exchanging cash manually, so be sure to have full and complete access 
to the spreadsheet (and the pool money) at all times while running your pool.  Don't use this spreadsheet with or for 
anyone whom you don't trust implicitly. The author (me) nor DK Digital Media hold no responsibility and are not liable 
for any improper usage of this spreadsheet. So there.  

Derby Day is a copyrighted work of Dave Kalin and DK Digital Media. All derivative works must include this copyright 
notice. 

 

Credits/Contact Information 
I hope you enjoy using this spreadsheet for your Derby Day party. If you have any comments or suggestions, or would 
like to send a small donation for my hard work, please contact me at: 

Email: kalin@dkdigital.com  
PayPal: https://paypal.me/dkla/ 
Venmo: @DaveKalin 
CashApp: $DaveKalin 
Zelle: davekalin@gmail.com 

BTC: 18YET57fBq4AdsCqU4wERPSAUhgqQS7KmL 
LTC: Li1MnqAFmMgdAjUFzgfeh2rQSd67wB9aok 
 

 

Thanks, and enjoy your Derby Day!!! 

 


